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1 Single user installation  
The SimaPro 7.3 installation file installs all versions of SimaPro. You have to enter the registration 
name and code during the installation.  
 
You can always download the latest installation file from http://www.pre-sustainability.com/install. 
Alternatively, you can find the installation files on the SimaPro 7.3 CD-ROM.  
 
The installation program will install the SimaPro version and accompanying databases based on your 
registration name and code. After installation, activation is required when you start SimaPro, except 
for the educational SimaPro Faculty license. 
 
Please note that for each user license you have one activation, i.e. only one installation is possible. 
To move SimaPro to another computer, you first need to de-activate. Deactivation is only possible by 
uninstalling the software while connected to the internet. 
 
For guidance on updating the software and database, please see the appropriate documents. You 
can check for updates via the Help menu in SimaPro. 
 

1.1 Installation procedure 

1.1.1 Installation 

 
Step 1 Download and install the SimaPro pre-installer file from http://www.pre-

sustainability.com/install or insert the SimaPro 7.3 CD-ROM in the CD-ROM drive. An 
installation menu appears on the screen. If it does not appear: 

 Start Windows Explorer 

 Select the CD-ROM drive 

 Double click on ‘CDSTART’ 
 

Step 2 In the installation menu, click on ‘installation’ and click ‘Install SimaPro’. 
 

Step 3 Follow the instructions on the screen.  
 
The end-user needs read-write access to the directory where the database is installed. 
You can choose a different installation directory for the database (please refer to 
paragraph 2.3.1 step 4 for the default directory), for example a server drive. This may be 
preferred for backup reasons.  

 
Step 4 Upon starting SimaPro for the first time, you are asked to activate your license. You can do 

this automatically via the Internet. If the connection with our activation server is blocked by 
a firewall, please choose one of the manual options. See also paragraph 2.2.4. 
 

Now you are ready to start using SimaPro!  
 

1.1.2 Using the single user database on a network drive 

It is possible to use the database on a network server. This may be preferred for backup reasons. 
Note however that a single user database can only be opened by one user at a time.  
 
During the installation, you can indicate the drive and path where the SimaPro database must be 
installed. If you have already installed the database in the default directory (see paragraph 2.3.1 step 
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4), you can move it to a new location. To move the database, make sure SimaPro is closed. Using 
Windows Explorer, move or copy the database(s) to a new location on the server.  
 
A SimaPro 7.3 database consists of 77 numbered files with the extension *.nx1 (from ***00.nx1 to 
***76.nx1). It is important that you copy or move all files at once, as the files are interconnected.  
 
Next, start SimaPro and choose Open SimaPro Database under File in the menu. Choose Browse and 
select the database directory on the server. If you do not use the locally installed database, you can 
delete it.  
 

2 Multi-user installation 
The SimaPro 7.3 multi-user installation installs both temporary and indefinite licenses of all SimaPro 
7.3 multi-user versions, including the educational Classroom version. You must enter the registration 
and code during the installation. The installation of the multi-user version has 2 steps: 
 

1. Install SimaPro Database Server 
2. Install the clients 

 
You can download the latest installation file from http://www.pre-sustainability.com/install. 
Alternatively, you can find the installation files on the SimaPro 7.3 CD-ROM.  
 
The installation program will install the SimaPro version and accompanying databases based on your 
registration name and code. After installation, activation is required except for the educational 
Classroom version. 
 
Please note that for each user license you only have one activation, i.e. you have as many 
installations as you have users. To move the SimaPro client to another computer, you first need to 
de-activate. Deactivation is only possible by uninstalling the software while connected to the 
internet. 
 
For guidance on updating the software and database see the appropriate documents. You can check 
for updates via the Help menu in SimaPro. 
 

2.1 Multi-user configurations 
 
SimaPro multi-user is a so-called client-server application. The client is the SimaPro 7.3 multi-user 
software, which performs the calculations and handles the user-input. The server is a program that 
controls the storage of the data and checks the number of users, and is called SimaPro Database 
Server. The SimaPro Database Server allows multiple clients to work within a single SimaPro 
database. So you need a computer (e.g. a server) to run the SimaPro Database Server and 
computer(s) (desktop or laptop) to run the SimaPro multi-user clients. In most cases, you use a 
Windows 2003 or 2008 Server, or a dedicated computer to run the SimaPro Database Server. 
However, it is possible to install both the client and the server on the same computer as well. 
 
When the SimaPro database server and SimaPro clients are connected by a (wired) Local Area 
Network (LAN) then the SimaPro Database server can be installed on a network server. In case a 
wireless network is used, it has to be a high speed, high bandwidth network to be able to handle the 
large data traffic, otherwise calculations might be slow. 
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When  the connection is a long distance connection (WAN), VPN, or remote sites, then the SimaPro 
Database Server should be installed on an application server like Microsoft Remote Desktop or Citrix 
XenApp (see Appendix: Terminal Server Configurations). 
 

2.2 Configurations on a Windows network 

2.2.1 SimaPro Database Server on network server 

This is the most likely configuration: 
 

 SimaPro Database Server: on Windows 2003/2008 server 

 SimaPro client: on Windows XP, Windows Vista or Windows 7 

 Protocol: TCP/IP  

 Network: Wired Ethernet 
 

2.2.2 SimaPro Database Server on a workstation 

SimaPro Database Server can be installed on any workstation with a Windows operating system. 
When a SimaPro user wants to run SimaPro 7.3 multi-user, both the workstation and SimaPro 
Database Server must be running so SimaPro can connect to the multi user database.  
 
The SimaPro Database Server and SimaPro client can be installed on the same computer.  
 

2.2.3 Installation on a terminal server 

You can install SimaPro Database Server and SimaPro multi user on an application server like 
Microsoft Remote Desktop or Citrix XenApp (see Appendix: Terminal Server Configurations). This is 
recommended in case of long distance connections (WAN), VPN and remote sites. The maximum 
amount of concurrent users is defined by the license.  
 
The users connect to the terminal server. Both server and client are installed on that 
computer/server. Users start SimaPro within the server machine to which they are connected.  
 
Depending on the configuration, activation for each “user box” may be necessary. 
 
No installation of SimaPro on client computers is needed, only the client software of the terminal 
server. In case of Windows Remote Desktop Connection it is included in Windows XP and higher. In 
case of Citrix, the Citrix client has to be installed once per workstation. 
 
On Windows Server 2008 R2 the firewall is not automatically configured, you need to do this 
manually, both for the SimaPro database server program and the SimaPro client. 
 

2.2.4 Firewalls  

SimaPro uses TCP/IP ports 16001 and 17001. If a firewall blocks these ports, the SimaPro Database 
Server will not be found. Note that previous SimaPro versions used ports 16000 and 17000. 
 
Some firewalls recognize new executables by size and version number. After an update you might 
need to reconfigure your firewall. 
 
On Windows XP, the SimaPro software is added to the accepted programs list of the firewall during 
installation. 
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On Windows Server 2008 R2 the firewall is not automatically configured, you need to do this 
manually. 

2.2.5 Compatibility with Antivirus software 

With recent versions of Windows, such as 2008R2 Server, some antivirus programs can interfere 
with the operation of the database server when they detect that database files have changed. In 
these situations, users may receive access violation errors at what appear to be random intervals.  
 
To avoid these problems, it is recommended that you add the .NX1 files in your data directories to 
the list of virus scan exceptions. This will prevent the antivirus software from obstructing access to 
your data. See sections 2.3.1 and 2.3.4 for more information about default data directories and the 
aliases that reference them. 
 

2.3 Installing SimaPro 7.3 Database Server 

You can install the Database server as a console application or as a service. On most servers it is 
recommended to install as a service. The difference between a service and a console application is 
that you have to start the console application to get it to work, like any other software package.  A 
service, on the other hand, is started automatically when the computer starts. It usually does its 
work ‘in silence’ and unattended. 
 
Please note that you may need Administrator rights for the computer to install the software. 
 

2.3.1 Installation as a standalone application 

Follow this procedure to install the database server as a standalone application. To install as a 
service, see the next paragraph. Note: we recommend this installation is done by experienced 
personnel in your IT department. 
 
Step 1 Download and install the SimaPro pre-installer file from http://www.pre-

sustainability.com/install or insert the SimaPro 7.3 CD-ROM in the CD-ROM drive. An 
installation menu appears on the screen. If it does not appear: 

 Start Windows Explorer 

 Select the CD-ROM drive 

 Double click on ‘CDSTART’ 
 

Step 2 In the installation menu, click on ‘installation’ and click ‘Install SimaPro Database Server’. 
 

Step 3 Follow the instructions on screen.  
 
Choose ‘As standalone application’ at the question ‘Install SimaPro Server as a service or 
standalone?’ 
 
The default directory for the software is ‘\Program files\SimaPro 7.3 Database Server’. 
 
The default directory for the database is 
 Windows XP and 2003 Server: 

 ‘\Documents and settings\All users\(shared) documents\SimaPro\Database’ 
 Windows Vista, Windows 7 and 2008 Server: 

 ‘\Users\Public\Public Documents\SimaPro\Database’ 
 

Note that the database server needs read-write access to the directory where the database 
is installed. 
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2.3.2 Install SimaPro Database Server as a service  

Only for system administrators  
 
Installing SimaPro Database Server as a Service has the advantage that you do not have to login into 
Windows Server to start the SimaPro Database Server. 
 

Choose ‘As service” at the question ‘Install SimaPro Server as a service or standalone?’ 

 
A user named “SPServiceUser2” is automatically created. This user is granted “logon as a service” 
rights. Note that this user is deleted on uninstall, however the profile is not. You have to delete the 
user and the user profile to erase all traces. 
 
When SimaPro Database Server is ready and running, you can proceed with installing the SimaPro 
7.3 multi-user (client) program.  
 
System administrators can use the Windows Service Controller (Start->Run->services.msc /s) to 
review and manage what the installer has created. The service name is “SimaPro 7.3 Database 
Server”. Alternatively, the small application “ServiceController” has been created to install, start, 
stop and uninstall the database service. 
 
2.3.3 Manually install as a service 

To start the SimaPro Database as a service after installing as an application use the command: 
NxServer /install /start /UserName:aUsername /Password:aPassword 
 
You need a user that has “logon as a service” rights. You can check this in “administrative tools”, 
“local security policy” (or Start->Run->secpol.msc /s) then “local policies”, “user rights assignments”. 
 
On installation as a service, SimaPro automatically creates the following user: 

Username = 'SPServiceUser2' 
Password = 'Exus2006$' 

 
You can use these details if you want to install the service manually. For example, after 
testing the SimaPro Database Server console application. 

 

2.3.4 Change server settings 

To change settings in the SimaPro Service start the database server management program 
(command: NxServer, or Start->All Programs->SimaPro 7 Database Server->SimaPro 7.3 Database 
Server). First, the service is stopped. Make your changes. When you exit the management program 
the service is restarted with the new settings. If you are using Windows Vista or higher, please 
remember to run the management program as an administrator (right-click the application icon and 
select: Run as Administrator). 

 
Important-> Opening the database management program when the database is running as a service 
will log out all current users! 
 
Information about the settings in the SimaPro database server can be found in the help file. The 
most common settings that are changed: 
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Server Name  
The name of the server as it is shown in SimaPro 7.3 multi-user (client). By default, this is “NexusDB”. 
Set this name once when you are installing SimaPro Database Server and never change it afterwards. 
Hence, if you change the name, you have to change it in all SimaPro multi-user installations as well. 
 
Aliases (Database directories) 
These are the directories where the SimaPro databases are stored. You can store multiple databases 
in one directory. The directory is not visible in SimaPro multi-user client, only the Alias is visible.  
The name of the alias can only contain text, numbers and underscores. 
 
Example: 
 Alias = ‘Default’ 

Directory = ‘\Document and settings\all users\documents\SimaPro\Database’ 
 

2.3.5 Best practices for managing user groups with several databases  

If you have groups of users who have their own databases and often work independently of each 
other, there are some limitations to be wary of and guidelines you can follow to simplify the 
independent management of these databases. 
 
One drawback of creating several databases under the same alias is that all databases must be 
closed if database management tasks need to be applied. Also, while database management tasks 
are being applied to one database, all other databases will be unavailable. These management tasks 
include:  

 Opening one of the databases with “local server” access; 

 Checking for database errors; or  

 Updating the library data or methods.  
 
The solution to these problems is to create separate aliases for each database using the 
management program (see 2.3.4). At a simple level, each alias corresponds to a separate directory 
on the databases server’s file system. 
 
Imagine the following scenario: 

User group Alias Directory 
Energy Energy C:\Document and settings\all users\documents\SimaPro\Database\Energy 

Consumer goods FMCG C:\Document and settings\all users\documents\SimaPro\Database\FMCG 
Medical Medical C:\Document and settings\all users\documents\SimaPro\Database\Medical 

 
If the above alias and directory structure is used, then all three groups can independently manage 
their databases without the other groups being affected. Please remember to run the database 
management program with administrator privileges (right-click the icon: Run as Administrator) when 
adding aliases. 
 

2.4 Installing SimaPro 7.3 multi-user (client) 

The SimaPro 7.3 installation installs both temporary and indefinite licenses of Professional multi-user 
versions and educational multi-user Classroom. You must enter the registration name and code 
during the installation. The client must be installed on a local computer. 
 
You may need Administrator rights for the computer to install the software. Please contact your IT 
department for details on how to login with Administrator rights.  
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If you install clients for the SimaPro Classroom version: please read paragraph 2.62.6 Error! 
Reference source not found.on automatically configuring clients to avoid extra work. 
 
Please note that SimaPro Database Server must be installed first! 

 

2.4.1 Installation 

Step 1 Download and install the SimaPro pre-installer file from http://www.pre-
sustainability.com/install or insert the SimaPro 7.3 CD-ROM in the CD-ROM drive. An 
installation menu appears on the screen. If it does not appear: 

 Start Windows Explorer 

 Select the CD-ROM drive 

 Double click on ‘CDSTART’ 
 

Step 2 In the installation menu, click on ‘installation’ and click ‘Install SimaPro’. 
 

Step 3 Follow the instructions on the screen.  
The default directory where the software is installed is ‘\Program files\SimaPro 7.3 multi’ 
 

Step 4 After starting SimaPro, activation is required, except for the educational Classroom license. 
You can do this automatically via the Internet. If the connection with our activation server is 
blocked by a firewall, please choose one of the manual options. See also paragraph 2.2.4. 
 

Step 5 Selecting the server 
 After starting SimaPro 7.3 multi user, select ‘Open SimaPro database’ under File in the 

menu. In most cases the SimaPro Database Server name appears on screen. It will show as 
SPSERVER@10.46.0.7, SPSERVER@MYSERVER.MYDOMAIN or SPSERVER@EXAMPLE.ET (only 
examples!). 

 
 If a server name does not appear, click on the ‘Servers’ button, next click ‘Scan’. If the list 

stays empty, click ‘New’ and type in the name of the SimaPro Database Server in your 
organization. You can find this name in the SimaPro Database Server, it is a combination of 
the server name and the IP address (ServerName@IPAdress). The server name is found 
under Server Engine in the General section, the IP number is found under TCPIPv4Transport 
at the Local Address.  

 
 Type the name correctly as typing errors will prevent SimaPro from finding the server. 

Next, click OK and SimaPro will try to connect to the SimaPro Database Server. If 
successful, a list of locations will appear. Locations are aliases for directories on the 
SimaPro Database Server. Note that only databases in one of the aliases can be opened. 
Aliases (an alias points to a location) can only be created using the SimaPro Database Server 
software. If you use a professional license, you can also select the local server in which you 
can use the browse options to point to a local directory. 

 
Step 6  Log into the database as Manager. By default, there is no password for the manager 

defined, simply leave the password field blank. To login as one of the predefined users, use 
the user name as the password.   

 To change the manager password (highly recommended), or to create new users and user 
types, go to User Management under Tools in the SimaPro menu. A special wizard will assist 
you when you need to create multiple user accounts. 

 The Manager has all the rights to edit the database, import data, and create users and user 
types with different access possibilities to the various projects. Please make sure that the 
person who manages the database in practice, knows the manager password and the 
associated responsibilities.  
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2.5 Using SimaPro Multi user as pseudo single user  

All professional SimaPro multi user clients can work as pseudo single user version, if the multi user 
client is installed locally. This means that Multi user users can work in SimaPro as if it was a single 
user version on a database that is stored on the computer locally. This is especially useful for 
updating databases or showing result to clients on location. Note that this feature is not available in 
the Classroom license.  
 
SimaPro databases on the local hard drive can be opened by choosing “Local server” in the open 
database window. Next, browse to the directory where a SimaPro database can be found.  
 
When you copy a SimaPro multi user database to the local hard drive, make sure no users are logged 
in and that you copy all 77 *.nx1 database files at once. 
 
Note: If a multi-user database is copied that is protected with a manager password, this password is 
needed to open the database locally! 
 
We recommend that users work (modelling/adding data) in the multi user version, and local copies 
opened in the “pseudo single user” are used for viewing or calculations only as changes made in the 
local database will not be reflected in the multi user database! 
 

2.5.1 Transferring projects 

Databases cannot be synchronised, projects can only be imported into another database, 
overwriting the projects with the same name. So try to work in the shared multi user database as 
much as possible. If users work in several pseudo single user databases this can give synchronisation 
problems. 
 
To move projects from a local database to the multi user database on the server, you need to import 
the project(s) on which you have worked into the multi user database. You need to use the Import 
SimaPro Database function under the File menu, which is only available when you log in as manager. 
 
Make sure that no other users have worked in the same projects in the shared database, as their 
work most certainly will be overwritten. Even though a back up is made on import, it may be difficult 
to synchronize these data with your own.  
 
Never copy or move a database from your local hard drive to the location of the multi user database, 
this will overwrite all data and destroy all new work made by other users (unless you are absolutely 
sure no one has worked in the database). 
  

2.5.2 TCP Problems 

Sometimes SimaPro cannot find the local database server. This is caused by the fact that Windows 
disables TCP/IP when the computer is not connected to a network or internet. To enable TCP/IP in 
this situation you need to activate the ‘Local loopback adaptor’. This is in fact a setting in Windows. 
Search the Microsoft Knowledge Base for installation guidelines. 
 

2.6 Installing client software centrally (Classroom) 

This procedure only works for the educational SimaPro Classroom license. Do not use it for the 
professional multi user version, as deactivation of the multi user client software will not be possible.  
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In a multi user environment with many clients, as is the case with the SimaPro Classroom, you can 
use this procedure to speed up the rollout. It also prevents you from updating all client installations 
when an update is available, as there is only one client to update. 
 
 

1. Install the SimaPro multi user client on the server in a Shared directory or directory in which 
the target group has read access. Alternatively, copy an existing SimaPro multi user client 
installation (SimaPro.exe + DLLs and other files) to a shared directory. 

2. Copy the SimaPro.LCS file to this Shared directory as well.  
 
Default locations for this file are: 
 
Windows XP and 2003 Server: 
  C:\Documents and Settings\All Users\Application Data\SimaPro\Multi 
 
Windows Vista, Windows 7, Windows 2008 Server and Windows 2008R2 Server 
   C:\ProgramData\SimaPro\Multi 
 

3. Create a shortcut on all users’ desktops or start menus. You can use logon-scripts, profiles or 
other network management tools. 
 

4. Use command line parameters in this shortcut. For an overview of all command line 
parameters please refer to the Help menu of the SimaPro Database server.  
 
Example:  
F:\Shared applications\SimaPro\SimaPro.Exe /Server:SPServer@central.local /Alias:default 
/Database:Professional 
 
(NOTE: The command line parameters Server, Alias and Database will not work if the user 
has opened a database in SimaPro before.) 

 

2.7 Importing Users from Windows 

You can import users from Windows or Active directory with a wizard. Go to Tools, User 
Management, Users and click ‘import users’. 
 

1. Select a domain, a computer or an Excel file.  
2. Select the users and groups you want to import. 
3. You can choose to create a project for every user. 
4. You can choose to create passwords. 
5. The results are stored in an Excel file that you can use to mail merge the users. 
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3 SimaPro 7.3 system requirements 
3.1 SimaPro 7.3 single and multi user client 

3.1.1 Operating system (O/S) 

SimaPro 7.3 is a 32-bit Windows application. It runs on Windows XP (32/64 bit), Windows Vista 
(32/64 bit), Windows 7 (32/64 bit), Windows 2003 Server, Windows Server 2003 R2 64 bit, Windows 
Server 2008 and Windows Server 2008 R2 64 bit. It is highly recommended to have the latest service 
packs installed. Earlier operating systems are not officially supported. Be aware that Windows Vista 
and Windows 7 allow for much larger LCA models than Windows XP due to their improved memory 
management. 64 bit operating systems allow for even larger models. 

3.1.2 64 bit Windows O/S 

SimaPro 7.3 can be used under a 64 bit Windows operating system without any problems. If enough 
memory is installed it can even run better than under a 32 bit O/S, especially if you calculate very 
large models.  

3.1.3 Internal Memory 

We recommend at least 2 GB of physical memory. The amount of memory needed for a reasonable 
performance depends on the size of your SimaPro database and the structure of the models you 
make, plus any other applications you run simultaneously.  If you plan to do calculations on large 
models or extensive Monte Carlo analysis, more memory is recommended. 
 
SimaPro on its own, i.e. excluding O/S requirements, uses a minimum of 100 MB RAM and typically 
about 250 MB. If you are calculating extremely large networks the memory usage can go up to 
2.5 GB or more. This is only possible if Windows can access more than 3 GB of memory, which is 
supported by 64 bit operating systems.  

3.1.4 Screen resolution 

The minimum resolution for SimaPro is 1280 x 1024, recommended is a higher resolution, a wide 
screen monitor works best. 

3.1.5 Processor 

SimaPro is a single-threaded application which does not use multiple cores. You only need a multiple 
core processor if other heavy applications are running. If this is the case, we recommend a 64 bit 
operating system. 

3.1.6 Hard disk 

Check if there is enough space on the hard drive. You need at least 2 GB disk space for your 
database(s) when using the single user version. For the multi-user version the database is found on 
the server, local hard disk space is not an issue, unless the database is used locally.  
In addition, SimaPro may need a minimum of 5 GB (recommended: 10+ GB) of free hard disk space 
for temporary files. 
 

3.2 SimaPro 7.3 Database Server 

3.2.1 Operating system 

The SimaPro 7.3 Database Server is a 32-bit Windows application. It runs on Windows XP (32/64 bit), 
Windows Vista (32/64 bit), Windows 7 (32/64 bit), Windows 2003 Server, Windows Server 2003 R2 
64 bit, Windows Server 2008 and Windows Server 2008 R2 64 bit. Earlier operating systems are not 
officially supported. It is highly recommended to have the latest service packs installed. 
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3.2.2 Internal Memory  

We recommend a minimum of 1 GB internal memory. 

3.2.3 Hard disk 

Although SimaPro Database Server itself is small (10 Mb), at least 1 GB space is needed for each   
installed database. 
 
 

4 Using SimaPro in special situations 
4.1 Running SimaPro with Terminal Services 

Because SimaPro is an executable without the need of many dlls, you can run SimaPro with Windows 
Terminal Service or Citrix XenApp easily. SimaPro uses no special external programs, except for the 
Excel link if Excel is running. If Excel is not running on the computer, SimaPro reads the Excel files 
directly. See also the appendix. 

4.2 Running SimaPro on Apple or Linux 
SimaPro works with Windows operating systems. Should you wish to run SimaPro on a Macintosh, or 
a PC with Linux as operating system, you need to use Windows emulation software. Note that as the 
emulation software itself will use a lot of internal memory, you may need to add memory to your 
computer to achieve reasonable performance. 
 
Please note that we do not support, nor guarantee the functionality of SimaPro on non-Windows 
operating systems, even when it is run using emulation software. You do this at your own risk; PRé 
or their local partners cannot provide any technical support to solve problems. 
 
Remote access to a Windows computer on which SimaPro is installed may be a suitable workaround. 
 
 

5 Activation 
The SimaPro software has to be activated at the first start-up. Activation is not needed for the 
educational Classroom and Faculty licenses.  
 
During the activation process, no personal information is collected. The activation is based on a 
“machine-ID”, which is generated by SimaPro from the hardware properties in a PC. This makes the 
activation code specific for the computer for which it was requested. 
 
Note that for each user license, you have only one activation. If you want to move SimaPro to a new 
computer, you must uninstall the software while connected to the internet.  
 
See also the SimaPro FAQ at http://www.pre-sustainability.com/faq. 
 
 

6 Updates 
PRé Consultants will regularly make software and database updates available to users with a valid 
service contract. To inform you of the availability of new updates, it is important that we have your 
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correct contact details, most importantly your e-mail address. Please notify us of any changes in 
your contact details, or if the main contact person for SimaPro changes. 
 
You can check if updates are available via the ‘Check for updates’ option under Help in the SimaPro 
menu. This option will check if the latest software is installed, not if all database updates are done. 
The check is only available if you have a valid service contract. Additionally you will find information 
on available updates in the About screen.  
 
Updates can be downloaded via our web site and come with clear installation instructions.  
If you do not have a valid service contract and want to install any updates, you need to upgrade to 
the current version first. Please contact PRé Consultants or your local partner for information on 
how to order an upgrade. 
 
 

7 Database backups 
You probably know that PCs, laptops and even network servers crash, get stolen, fall, get coffee 
spilled over them or become infected with a virus. You also know that your colleagues or your 
neighbour’s children may accidentally delete a project or perhaps a database file. You also know that 
neither you, nor your own children, will ever do these kind of things. And we at PRé Consultants 
know that although we succeeded in creating a very stable system, there still remains a very small 
chance that a SimaPro database will crash beyond repair.  
 
Murphy’s Law dictates there is a minor chance that such a problem will occur to you. But if it does 
happen, it will typically be just before an important deadline or just after you have spent a full week 
of entering data into SimaPro.  
 
Even though this sounds dramatic, in fact, it could be a relatively small problem. You simply get a 
new computer, reinstall SimaPro, and restore your latest backup so ideally you only lose a day’s 
work. If only you made that backup yesterday… 
 
Thus: do make regular backups. The backup should not be located on your own PC, but on a CD or a 
server drive for example. If your server is centrally backed up every night, make sure all the SimaPro 
database files are included, that the SimaPro database is not in use, and that it is indeed possible to 
retrieve the database from the backup file.   
 
So, start now with making a backup of your database. You can use the backup function in SimaPro, 
under File, Database Management in the menu. And remember to make the next backup soon! 
 
If you make central backups, this information will be useful: 
 

 When you make a backup, SimaPro must be closed and no users can be logged in the multi-
user version.  

 

 A SimaPro 7.3 database consists of 77 numbered *.nx1 files, in the format 
DatabaseName00.nx1 to DatabaseName76.nx1.  

 

 All files must be saved at the same time, as they are interconnected. 
 

 The default location of SimaPro databases is  
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Windows Vista, Windows 7, Windows 2008 Server: 
C:\Users\Public\Documents\SimaPro\Database\  
 
Windows XP, Windows 2003 Server: 
C:\Documents and Settings\All Users\Shared Documents\SimaPro\Database\  
 

 
Needless to say: we sincerely hope you never need your backup! 
 
 

8 Database compatibility 
Databases from previous SimaPro versions can be converted to SimaPro 7.3 database format 
without loss of data.  
 
SimaPro 7.0 and 7.1 databases 
SimaPro 7.0 and 7.1 databases are automatically converted to SimaPro 7.3 format on opening the 
database. A copy of the database in the original format is made with the extension “_version71” 
after the database name. This serves as a database backup.  
 
After conversion, the converted database cannot be opened with SimaPro 7.0 or 7.1 anymore. If you 
need the original database, open the renamed copy of the database with SimaPro 7.0 or 7.1.  
 
During conversion several checks are performed. If SimaPro tells you there are problems in the 
database, please save the error report.  In this case, run a database check (File, Database 
management, Check) and send the results of the check together with the error report to the 
helpdesk using the “E-mail helpdesk” option in the Help menu. 
 
Note that a technical conversion does not mean the database is updated with the latest data! You 
will still need to import the update database. See the update instructions that come with each 
database update. 
 
SimaPro 6.0 databases 
SimaPro 6.0 databases must be converted with a special conversion tool to SimaPro 7 format. Please 
contact the helpdesk for more information. 
 
SimaPro 5, 6, 7.0 and 7.1 CSV files 
CSV files in SimaPro 5, 6, 7.0 and 7.1 format can be imported by SimaPro 7.3 SimaPro 7 CSV files 
cannot be imported in SimaPro 5 and 6, due to the fact that the format has been extended. 
 
Previous versions 
Please contact us via support@pre-sustainability.com or phone +31 33 4555010 to obtain detailed 
information. 
 
  

9 Language support 
The SimaPro software can be run in various languages. To change the language in which SimaPro is 
run, go to Tools in the menu and select Language. Although SimaPro will instantly update with the 
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selected language, not all text is translated the first time. Therefore we recommend to restart 
SimaPro.  
 
Note that the SimaPro database, help file and manuals are only available in English.  
 
 

10 Support 
For technical support, first please check the support corner on our website to see if the answer you 
are looking for is already there: http://www.pre-sustainability.com/landingpages/support-corner . 
 
 If you live in a country where we have a partner, please contact that partner to receive support in 
your own  language; http://www.pre-sustainability.com/partners. 
 
To contact Pre directly, use the “Contact SimaPro helpdesk” feature under Help in the SimaPro 
menu. This will generate an email with technical information about your license, which helps the 
helpdesk to answer your question more quickly.  
 
You can contact the SimaPro helpdesk via: 

 In SimaPro: Help > Contact SimaPro helpdesk (recommended) 

 Web site : http://www.pre-sustainability.com/contact/support 

 E-mail: support@pre-sustainability.com 

 Phone: +31 33 4504010  
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Appendix: SimaPro directories 
 
Below you can find the default directories of SimaPro. It is assumed that C: is your default drive.  
 
Software 

Filenames: various 
 
C:\Program files\SimaPro 7 
C:\Program files\SimaPro 7 Multi 
C:\Program files\SimaPro 7 Database Server 
 
Manuals 

Filename: *.pdf files 
Subdirectory \Manuals of Software 
Check our website for the most recent versions of the manuals: 
http://www.pre-sustainability.com/content/manuals  
 
SimaPro 7.3 Database 

Filename: 77 numbered *.nx1 files, default starter00 to 76.nx1 or professional00 to 76.nx1 
 
Windows XP, 2003 and 2003R2 Server: 
 C:\Documents and Settings\All Users\Shared Documents\SimaPro\Database\ 
 
Windows Vista, 7, 2008 and 2008R2 Server: 
 C:\Users\Public\Documents\SimaPro\Database\  
 
License 

Filename: simapro.lcs, simapro.aii 
 
Windows XP, 2003 Server and 2003R2 Server: 
 C:\Documents and Settings\All Users\Application Data\SimaPro\[Single/Multi] 
 
Windows Vista, Windows 7, Windows 2008 Server and Windows 2008R2 Server 
 C:\ProgramData\SimaPro\[Single/Multi] 
 
User output and export 

Filenames: *.txt, *.xls, *.csv, *.bmp, *.xml  
 
The default location is the user’s “My documents/SimaPro” directory.  
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Appendix: Terminal Server Configurations 
Using terminal server software such as Microsoft Remote Desktop or Citrix XenApp is an ideal way to 
use SimaPro when users have limited bandwidth. This is often the case when users are connected to 
a Wi-Fi network, a WAN (wide area network) or through a VPN (virtual private network). VPNs often 
operate over public internet connections. 
 
At the time of writing, PRé has only tested SimaPro in conjunction with a VPN and Microsoft Remote 
Desktop Services (RDP). Although no XenApp servers are currently available to PRé Consultants, the 
added overheads of such an environment are assumed to be similar to RDP. When actual tests using 
these other packages are carried out, such experience will be added to this document. 
 
A number of our clients are currently known to be using SimaPro on XenApp or Remote Desktop 
servers. While we cannot give technical support on these specific implementations, we see no 
reason why such configurations should be problematic. Indeed, we believe that the investment in 
such environments will improve the user experience when bandwidth is at a premium. 
 

 
 

Figure 1: Terminal Server Configuration 

 
 
 

Technical Requirements 

This document is based on the experience of PRé Consultants’ with its own in-house terminal server. 
Its configuration is Microsoft Remote Desktop running in a VMware ESXi 4.0 virtual machine on a 
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Windows 2003 server with a maximum of 5 users1. Industry literature indicates that XenApp offers 
better security, better load balancing features, and a more natural feeling when connecting to the 
desired application. These features are more likely to be important when implementing a solution 
with a large number of users. The points below are based on our experiences and are by no means 
an exhaustive test of the capabilities and limits of such a solution. 
 
Server Requirements 

The minimum hardware requirements of the server are 2 GB of memory (RAM), a 2 GHz quad core 
processor and Windows 2003 server. Fast hard drives and about 1 GB of free memory are important 
as a lot of data is transferred between the SimaPro database server and internal cache buffers. For 
this reason, it is recommended to install the database server and files on the same disk array as the 
terminal server software. More memory will only be a benefit if you install a 64 bit operating or if 
you create separate virtual machines for the SimaPro database server and terminal server. Note that 
it is possible to have several installations of terminal server with the SimaPro client, all connecting to 
the same SimaPro database server. 
 
Regarding software, a default Microsoft Windows server installation only allows two remote desktop 
connections and is designed primarily for system administrator access. In the majority of cases, 
special “Terminal Server Client Access Licenses” have to be purchased from Microsoft for each 
intended SimaPro user. Additionally, the “Terminal Server Licensing Service” will have to be installed 
and configured. For Citrix, please refer to their web site for details of software and licensing 
arrangements. 
 
"Out of the box" the professional database occupies 1 GB of disk space. This only grows significantly 
when users copy entire libraries, especially those from ecoinvent. The database server software can 
use up to 10 GB of temporary disk space when accessed by multiple users, but this is managed 
dynamically based on available disk space. 
 

We have no market preferences for any hardware. Our own server, which performs very well, has a 
quad core CPU with 16 GB of RAM. Its good performance is likely due to its processing power, its 
15000rpm disks, its separation of different application servers using virtual machines, and its 
connection to a 1 Gbps local network. 
 

Client Session Requirements 

With Remote Desktop, each SimaPro client uses on average 250 MB with a session overhead of 
about 50 MB. Each session should have access to the equivalent of a single core 1 GHz CPU. 
Overworked local area networks (LANs) can have a serious impact on database functions, so it is 
recommended to use a 1 Gbps network.  
 
Processor and memory demands are relatively low except with functions such as calculating network 
trees with unit processes, comparing network trees, performing Monte Carlo analyses of several 
thousand runs, importing SimaPro databases, and copying projects, all of which require large floating 
point matrices or data buffers to be manipulated. In extreme cases the SimaPro client can use more 
than 2 GB of memory so be careful not to limit the available memory. Windows XP or later is 
recommended for the SimaPro client, and Windows Server 2003 or later is recommended for the 
SimaPro database server. 
 

For complex calculations SimaPro caches opened libraries in temporary files on the hard disk. So for 
optimal speed it is recommended to have at least 2-3 GB free disk space while using SimaPro. When 

                                                             
1 SimaPro supports up to 40 concurrent users. Memory limits of your terminal server are likely to be the 
limiting factor when connecting a large number of users. 
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SimaPro is closed these temporary files are deleted. If the user exports data, the file size will vary 
based on the quantity of data selected, i.e. anywhere between a few KBs and 1 GB. Exporting of 
graphs requires only a few kilobytes for JPEGs and about 1 MB for bitmap files.  
 

Remote Client Requirements 

Requirements for the remote client software are very low with the most important requirement 
being a stable communication link. SimaPro does not make use of animation or sophisticated 
graphical features, so a 128 Kbps upload/download link should suffice.  
For security reasons we recommend that terminal sessions should not be run from a public 
computer. Extra protection can be implemented hosting the terminal server in a DMZ (demilitarised 
zone) or requiring a secure VPN connection is made to the network hosting the terminal server. 
 
 

Installation 

There are no special requirements for the SimaPro client on a terminal server that are different to 
the installation of any other software packages in this kind of environment. With Citrix XenApp, the 
SimaPro client should be loaded in ‘install mode’. As mentioned before, install the SimaPro database 
server, database files and SimaPro client program on the same disk array for optimal performance. 
 
The SimaPro multi user version operates as a client-server system. Although not ideal, if the client 
and database are separated by a firewall device, then TCP and UDP ports 16001 should be open (for 
unsecured transport) and 17001 should be open (for secured transport).  
 
It is common for terminal server sessions to have limited directory creation privileges. To allow 
correct registration and activation of SimaPro, each session running the SimaPro client should have 
read/write access to the “Document and Settings/ProgramData” directories mentioned in Appendix: 
SimaPro directories. 
 
Unfortunately PRé Consultants does not offer software installation services. Our help desk will 
however answer any specific questions where possible and suggest other options to explore for 
questions outside their area of expertise.  
 
 

Maintenance 

Backups 

The SimaPro database files can be backed up in a multiuser environment, providing no users are 
editing the database. Unfortunately, no special software agents are available to guarantee a tape 
backup system can archive the database when it is being used. An alternative method is to use the 
manual backup function within the SimaPro client software. We recommend performing regular 
nightly backups in the early hours of the morning when all users are likely to be logged out. 
 
Database Server Crash 

In the event of a database server or machine crash, large temporary files may be left in the default 
Windows TEMP directory. In such cases, the SimaPro database server files may need to be removed 
manually and can be recognised by the format: XXXX_XXXXXXXX.tmp. The SimaPro client will always 
remove its temporary files automatically upon restarting the application. 
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Database and Program Administration 

Each database has a manager user with its own password. This is required to create user accounts 
and set project access rights, but these tasks only take a few minutes when they occur. The database 
manager has full access to all data and projects within a database.  
 
We recommend the client software is installed in a central location and a short cut is made in each 
client environment, as this minimizes the work needed when a client update is available.  
 
Locked User Sessions 

When using terminal sessions and SimaPro, it is possible for users to close their terminal session 
without shutting SimaPro down. This can occur if their communication link is broken or sometimes it 
is done intentionally, so users do not need to close off all their work (see  
Figure 2). When this occurs, the SimaPro client session stays active, which prevents the license from 
being used by someone else. Additionally, in rare cases, SimaPro can crash but its process stays 
active in memory, even though no user interface is visible. This will stop the same user being able to 
log back into SimaPro. 
 

 
 

Figure 2: Disconnected but active remote desktop session 

 
The solution to these occurrences is to either: 

 Open the terminal session again and shut it down properly, i.e. Log off; or 

 Open the Task Manager (left-click the task bar), select SimaPro.exe, and click End Process 
(see Figure 3) 

The latter option should only be done as a last resort as it does introduce the risk of corrupting the 
database. 
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Figure 3: Abruptly terminating SimaPro 
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